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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Introduction

This document describes how to add a Yaskawa AC Drive with an SI-EP3 Option to a PROFINET network using the

Siemens Step 7 software version 5.4.

Intended Audience

This document is intended for those involved in designing, installing and/or commissioning a PROFINET system including
Yaskawa AC Drives. It is assumed that the reader is familiar with Yaskawa AC Drives, PROFINET and Siemens Step 7
programming. Familiarity with the SI-EP3 Option and with the A1000 and V1000 installation guides and technical manuals is

highly recommended.
References

Siemens documentation may be downloaded from
49948856
45531107

Following manuals may be downloaded from
SIEPYEACOMO7

SIEPYEACOMO6

SIEPC71061641

SIEPC71060618

PROFINET information may be downloaded from

https://support.automation.siemens.com
SIMATIC PROFINET with STEP 7
SIMATIC Programming with STEP 7 V5.4

https://www.yaskawa.com

1000-Series Option SI-EP3 PROFINET Technical Manual
V1000-Series Option SI-EP3/V PROFINET Technical Manual
Yaskawa 1000 Series AC Drive Technical Manual

Yaskawa V1000 AC Drive Technical Manual

https://www.profibus.com/technology/profinet/
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Create Step 7 Project

Create Project

e Open the Step 7 software
e  Select New from the File menu
e Enter the project Name
e Select OK
IJ SIMATIC Manager
Select File

New

Page Setup...

1 Accessible Nodes — MPI

Exit

BN

Creates a new project or a new library.

Figure 1 -- Create Project

FJ SIMATIC Manager =]
File PLC View Options Window He

D e |8 & | 7| @2

User projects |L|hranas| Multlprmectsl

Mame | Storage path |

Enter project Name

= Add b current multiproject

ame: Tvpe:
Select OK IPHDFMEt IF‘rDiact =
I~ E Libram

Storage location [path):

IC:\F’rogram Filez\Siemenz\StepPa7pioj Browse... |
QK | Cancel | Help |

Z|

1

Press F1to getHelp.

Figure 2 -- Project Name
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software
Add Station

e  Select Station from the Insert menu
e  Select the Station Type (SIMANTEC 300 Station for this example)
e Double Click on Hardware

ES\MATIC Manager - [PROFInet - C:\Program Files\siemens\5tepf\s7proj\PROFInet]
Insert PLC View Options Window Help

1 SMATC 40 Saion s [<Ti o> % we mEmN
2 SIMATIC 300 Station
/ 3 SIMATIC H Station
4 SIMATIC PC Station
Select Insert i
6 SIMATIC 55
. M7 Software ST
Station L
Symbol Table
/ Text Library, v
Select Station Type Esternal Source...
Inserts SIMATIC 300 Station at the cursor position. =
Figure 3 -- Select Station
_r.'! SIMATIC Manager - [PROFInet - C:\Program Files\Siemensg\5tepTisTproj\PROFInet]
&g File Edit Insert PLC View Options Window Help -1=] x|
O |80a 8 Bl ez %2 & |[<No Fiter > % |%®e | BB M
FPROFInet
Double Click on

Hardware /

Press F1to get Help. [ [TCP/IP(Auto) > ASIX AX88178 USB2.0 | 5

Figure 4 -- Open Hardware Configuration
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software
Add GSD File

e  Select Install GSD File from the Options menu
e Select the GSD file to install
e Select Install
e  Select Close
~u E T | | E || ‘ Customize... Ctri+Al+E
Iy Specify Module... =
Select Options i) six
Symbol Table CArlsAIT Find | ﬂlﬁl
Report System Error... Profil: ISlandard j
Edit Catalog Profile [+ 1% PROFIELS DF
Update Catalog 22 PROFIEUS-Fa
22 PROFINET 10
. Install HW Updates ...
Install GSD File —> SMATIC 40
PR SIMATIC PC Based Control 300400
Find in Se & Support...
it B, SIMATIC PC Station
Create G50 file for I-Device...
PROFIBUS-DP slaves for SIMATIC 7. M7, 3
and C7 [distributed rack] -
« | ;l"
Installs new G5D files in the system and updates the contents of the catalog. | | l_ 2
Figure 5 -- Install GSD File
. =[]
Select GSD File @y station Edit Insert Instal GSD Files: sy [From the: lvectory = =12l
Location = 2.
J D=s gﬂ' | =4 IC:\Trans\GSD Browse ... |
Bl=l
Releaze “ﬂ ﬁ=|
SeleCt .3 Default j
SI-EP3 GSD File — YASKOACF. gsd Dietault =
b,

Fiased Control 300/400
5 tation

Select Install \

Select Close \ A
\ Install | Show Log Select Al Deselect Al Clz?r SIMATIC 57, M7, <

4
Press F1 to get Help. Close I Help e e

Figure 6 -- Select SI-EP3 GSD File
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

from the Object menu
Rack and Rail

Add CPU

e Select Insert Object

e Select Station Type,

e Select CPU from catalog
[ ]

Select Insert ?

Insert Object

Select Station ——"

Select Rack

Select Rail /_

Select CPU
From Catalog And
Drag it to designated

Drag CPU to highlighted slot in the system rack

[B4 Hw Config - [SIMATIC 300(1) (Configuration) — PROFinet]
i Insert PLC View Options Window Help

Insert Object...
Replace Object..,

Master System
PROFIHET 10 System

4 |

==
=
- oixl
End | ﬁ:l: aﬂ
Frafile: IStandard j

Y PROFIBUS DP
2 PROFIBUS-P&
B2 PROFINET 1D
SIMATIC 300
SIMATIC 400
SIMATIC PC Based Control 3004400
B SIMATIC PC Station

PROFIBUS -DP slaves for SIMATIC 57, M7,
and C7 [distributed rack]

%

Inserts an object to be selected at the position marked.

=

Figure 7 -- Insert CPU Object

E[;. HW Config - [SIMATIC 300{1) (Configuration) — PROFInet]

By station Edit

Ingsert PLC Yiew Options Wndow Help _|5|1|
D22 a ce aalmD/ e
88 Lo OFIBLS DP E= EE
B PROFINET IO End | “ﬂ ﬁil
[|&@c? Brofile: [ Standard =l
L Gat
= Hz;,?_:ﬁr -9 PROFIELS DF
= Rl BB PROFIBUSPA
/ A& PROFINET 10
SIMATIC 300
SIMATIC 400
SIMATIC PC Based Contiol 300/400
B 5IMATIC PC Station
PROFIEUS-DP slaves for SIMATIC 57, M7, 3
and C7 [distributed rack] -
=
4 | _'l_I
Press F1 to get Help.

e

[ HW Config - [SIMATIC 300(1) (Configuration) - PROFinet]

Figure 8 -- Define Inserted Object Type

@y Station Edit Insert PLC View Options Window Help

Slot in system rack

12 July 2018.

=13 =|
[Dz28 §a aeaalBdm 2 e
7 Blx|
; < Find: I ﬂﬂ Nﬂ
; - Profile:  [Standard =l
= ~ D -3 CPU 315 -]
3 ~L a -3 CPU 3152DF
= ~ .E =3 CPU 3152 PN/DP
7 ~ o :
<L )

w0 CPU 316

BES7 315-2EH13-04B0 ﬂ
256 KB work memory; 0.1 ms/1000
instiuctions; PROFINET connection; 57
Communication [loadable FBs/FCs); LI

-
%

Figure 9 -- Add CPU to System Rack
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

- Ethernet interface PN-10 (R0/52.2)

Parameters

If a subnet is selected,
the next available addresses are suggested.

Configure CPU

e  Enter CPU IP Address and Subnet Mask

e  Add network

e  Enter network name

e Select OK
Properties
[y station Edit Insert PLC
D=8 By & e

Enter IP address =~—__

192.168.2.1

—Gateway

1P address

Enter Subnet mask —"
255.255.255.0

152.168.02.1
' Do not uss router
Subnet mask: 255.255.255.0
/ " Use router
Address:  |152.168.02.1

Subnet

M New. |
Propetties.. |

Select New =
To add network

4

| I

==

olxl

tandard

EE
1l CPU3152DP
1] CPU 3152 PN/DP
([ BEST 215-2EG10-0480
8 F_'| EES7 315-2EH13-04B0
o [E ves
8 ves
o [E vee
1] CPU315F-2DP
1] CPU 315F-2 PN/DP
1] CRU31E

H13-04B0 I E<|
memory; 0.1 me/1000

PROFINET connection; 57

I

b [loadable FBs/FCs);

oKk | Cancd | Hep | =l
Insertion possible - | Cha 2
Figure 10 -- Add IP Address and PROFINET Network
L5 i Config - [SIMATIC 30011) BEE
B station Edit Insert PLC P—— ==
JD@EW@.’H%II R =
General | ol
7 Tems [PROFIet ﬂlﬂl
i €7 subnet 1D Joota | - Joooa derd =
A Project path: | CPLU 315 =]
Enter network Name = Storage location LUy 2DP
6 of the project IC “Program Files\Siemens'\Step 7s 7proj\PROFinet CPU 3152 PN/DP
7 (] EES7 315-2EG10-04B0
o Author: | D BES?315 2EH130480
Date created 11/11/2011 02:23:15 PM \\gg J
Last modified 11/11/2011 02:23:15 FM 8 ves
Commert: =] CRU 31 5F-2 DP
Select OK CPU 315F-2 PN/DP
\ CPU 316
EIH
LI emor_l,l D‘I /1000
ROFIMET connection: 57
[loadable FBs/FCs);
Cancel Help i L]
Insertion possible - Cha
Figure 11 -- Configure PROFINET Network
[y Confia - [SIMATIC 30011
B station Edit Insert PLC =] =]
eneral  Parameters |
|ID=28 B |&| e
Blxl
If 3 subnet is selected, =
1 the next avaiable addresses are suggested L] 'l “tl'
2
3 tandard j
A P addeze: 19216821 rEaE 0 CRU 315 -l
i ' Do not use router |] CPU 315-2DP
Subnet mask: 255.265.255.0
6 i 11 CPU 3152 PH/DP
7 -7 BEST 315-2EG10-08E0
o Address:  [152.168.21 :|C| BES7 315-2EH13-04E0
Subnet: -8 ves J
; 8 v2s
— not networked — | New... 4 - [8] wzE
Select OK e 1] CPU 315F-2 DP
\ ""’e'“—al ) CFU 315F-2 PN/DP
Delete | 1] cPU 316
HT3-04EB0 I t<|
memary; 0.1 ms/1000
PROFIMET connection: 57
<| oK | I | Help | b (loadable FBs/FCs); LI
Insertion possible - | chg

Figure 12 -- PROFINET Network Added

Document: AN.AFD.31

12 July 2018.

Page 6



Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step

7 Software

Add Drive w/ SI-EP3 Option to PROFINET Network

Select SI-EP3 from catalog

Drag SI-EP3 to network

Select Object properties from the Edit menu
Enter the SI-EP3 name and device number
Enter SI-EP3 IP Address

Select the network connection

Select OK

Select the cyclic I/O

Drag the I/0 to the designated slot

Right click on memory and select Object Properties
Select Parameter tab

Select Control and Status Word Selection
Select either PROFIdrive or Yaskawa
Select OK

E[.. HW Config - [SIMATIC 300(1) (Configuration) — PROFInet]

By Station Edit Insert PLC View Options Window Help =12 x|
DS 8 &) 00| dadE e
5 Bixl
S =
1 T End | ﬁ:l: “i’l'
)2(7 f;rg;;ﬁz FI/DP J Erafile: IStandard j
PROFInet: PROFINET-I0-5, 100
“ S - yeen (00 =B PROFIBUS DP =
Jori|[ Pt -~ D 38 FROFIBUS P4
2 ~ L3 =2 PROFINET 10
= j ~ E'D_ &dditional Field Devices
= -~ - . EH_] Drives

Select SI-EP3

-~ @[:I SIEP3

From catalog and
Drag it to the network

ll |

el 51-EP3 Frofinet Option

SI-EP3
' askawa America, Ino
SI-EP3PROFIMET 10 module

GEDMLY2 2 askamwa-SIEP3-201 00726, 5ml

Le S

Insertion possible

[cha 4

0
=

Figure 13 -- Add SI-EP3 Drive to Network

E[:. HW Config - [SIMATIC 300(1) (Configuration) — PROFInet]

@y Station | Edit Insert PLC View Options Window Help NEET
g Com cutc  hpm| 88| ag|
Paste Ctrl+r
Insert Redundant = o=l
= (0) UR | E
:I End | nj_ i
1 Delete Del !
. 2 -
Select Edit X7 Select Al Ctri+h Brofie: |Standard =
PROFInet: PROFINET-I0-5 100
= GoTo , . R - PROFIBUS DP -
xX2pi P 222 PROFIELS-Pa
3 = -8 PROFINET IO
4 Mol oyatem =103 Additional Field Devices
3 PROFINET 10 : ;

Isochronous Mode

B ol Obicct Properties... Alt+Return

Open ObjectWith... Ctri+Ait+O

Object Properties =

Assign AssetID...

Start Device Tool

< |

{17 Gateway
{11
{27 Metwork Components

@ 3-EP3 Prafinet Option ¢

SI-EP3
' askawa America, Inc
SI-EP3 PROFIMET 10 module

GSDML2 2-vaskawa-SIEP3-201 007 26.5ml

Le Sl

Displays properties of the selected ohject for editing.

[cha 4

g

Figure 14 -- Configure SI-EP3 Option
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

General |
Short description SI-EP3
I-EP3 PROFINET 10 module ﬂ
Enter Device Name [ HW Config - [SIML |
Eaigtion =18
Order No. / Firmware: ~ SI-EP3./V1.0
D=s-B
SHER3
= ——aolx
Device name: NW Conveyor # I ﬂ.:l
2 CPU
X xi MPLT El
Enter Device Number ~J |« PO z
\& Poi T GSDfile: GSDML-V2 2-Yaskawa-SIEP3-20100726 ml
3 \ Change Heleaze Mumber |
4 Devices
=
MET IO System
Device number: |1 j IF‘FlDF\NEI'—IO—System (100) EP3 Profinet Optian €
IP address: 02 ER D Ly  Ethiemet ..
pnents L4
SeleCt Ethernet [V Assign |P address via 10 controller I »
To set IP Address e
B
Comment: !
le
4 | ;I P3-201007 26.xml
Press F1 to get Help. =l [cha
Cocd | o |
Figure 15 -- Add Name and Device Number
General |
Short description: SI-EP3
ls]—EPa PROFINET 10 module |
Properties - Ethernet interface SHEP3
Enter IP address Mmston Bk et Pames | =18 x|
DEe-B g
Famiy:
Blx|

Device nan

1 Nﬂ ﬁﬂ
7 CPU:
X1 MPVL =
x2 PO . - Gateway -
X2FP1 Port 1 GSD file: llmdde= & [0 ok use router
3 Subnet mask:
3  [se rauter Devi
Select ngtwork d . Mo [T — evices
Connection == e i -
E2L — not networked — REa £ P3 Profinet Option ©
IP addres ﬂl -
Select OK . _l;l
¥ fssig Delete I 4
\ =
Comment: -
le
q e | Help | =1 | [Fe2moo7ze s
Press get Help. LI W 7
oK | Cancel Help
Figure 16 -- Add IP Address and Network Connection
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

[ HW Config - [SIMATIC 300(1) (Configuration) —- PROFinet]

mglaﬁm Edit Insert PLC View Options Window Help -ﬁ'ﬁl

(D=2 e neaabD 2w

= End | ﬂlﬁl

CPU 3152 PN/DP J Profile: IStandard

MPLDP
L T ECORBUS PA
£ 48 PROFINET IO
¢ B0 Additional Field Devices
¢ B[] Drives
=-£2 5I1EP3

=1 E SI-EP3 Profinet Option

=] Drive Object

[ 1040 Profile
[ StdTgm1

Select cyclic I/O
Drag it to the T

Designated IO slot

PROFinet: PROFINET-I0-System (100)

I— 3 K

:I:I [1] MNw-Conveyor

Slat Madule Order number | Address | O address Diagnostic add... | C... I oo o s
FRStd Tam1 + 5 HES
N-Lonvesor SHEFR FPLFT -~ | i [ = = - B
fteace SR U .
Lt ? e SI-EP3 3
s — i Std Tgm1 + 5 FZ0 Module =
& GSDMLA2.2-Y askawa-5IEF3-201007 26, xml
Fress F1 to get Help. [ [ chg 4
Figure 17 -- Add Cyclic 1/0
Copy Ctri+C
Paste Ctrl+y:
Add Master System
Disconnect Master System
Insert PROFIHET 10 System:
HW Config - [SIMATIC 300{1) (Configuration) — PROFInet] Disconnect PROFIHET [0 System
@) Station Edit Insert PLC View Options Window Help PROFINET 10, Domain Management... == x|
J 0= 2. B | =3 || 2 || g g ”EE | am | k‘?| PROFIHET, I0 Topology..
Isochronous Mode I
ol x|
Specify Module... | E
1 5 _ ani
Right click on I/O slot A Sl e E|
X ) PROFInet: PROFIN Go To > =
X2 Por 7 T Filter, Azsigned Modules A
& BNy Monitor/Modify il
Select 4
Ob . P . 3 Edit Symbols...
ject Properties gl Ovrce Proverics. Ao | SRRSRERIAN
Open Object With... Ctri+AH+0 Station
Assign Asset ID...
| Address e} Product Support Information Ctri+F2
FAQs Ctri+F7
Find Manual Ctri+F&
Start Device Tool = for SIMATIC 57, M7, f<|
ATy TrSowET Tack) -

Displays properties of the selected object for editing. | l_ S
Figure 18 -- Cyclic I/O Properties
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Properties - 5td Tgm 1 + 5 PZD - (R

Genera]l Addresses Parameters |

=
@Y Stetion Edit | 7 =18 |
o — alue
J O =& %~ & =5 Parameters
. C —al
Select Profile [ 5 avt| i
\ 2 CPU3 |
b X7 MPLDF
o~ _vio o
X2FI -
3
1 0
E—— ion
bl I o Yaskawa j Contral 3004400
ﬂ:l 1] Mw-G PROFIDiive
0
0
Select OK - MATIC 57, M7 E
L[| parameter number []
4
Cancel Help
Figure 19 -- Control and Status Word Configuration
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Assign Device Name

All PROFINET devices must have an assigned name. Assigning a name to a device requires that the device be connected to
and can be seen by the network. Although it is not necessary to assign device names at this point, the process is shown here.

PLC View e EE
Select PLC _____--—"?D @ 2.8 &g Download.. )

& ol x|
=S Download Module Identification... — I =
1 Upload Module Identification to PG... At EIE‘I
Pl e Brofle:  [Standard [
NET-I0-System (10
42 Module Information... Ctri+D RO (1 ¥ PROFIBUS DP
=dl Operating Mode... Ctri+ -5 PROFIBLIS-PA
3 A B2 PROFINET 10
4 St Df'l']' SIMATIC 300
= ime V... SIMATIC 400
Select Ethernet \ Monitormodiy: : SIMATIC PC Based Contral 300,400
1 Update Firmware... -8, SIMATIC PC Station
Save Device Hame to Memory Cand...

gt Enernet ode
Sele.Ct . LI—I PROFIBUS »  Verify Device Name... US-DP slaves for SIMATIC 57, M7. and C7 [distributed ES
ASSIgn DeVlce Name :I:I [1] WwConveyor Save Service Data... F

Assignment of PROFINET IO device names. [ Chg .z

Figure 20 — Assign Device Name

[ HW Config - [SIMATIC 300(1) (Configuration) — PROFInet] 5 [=] E3
B station  Edit e R - | =l
[ = =;
J O = a~ gﬂ | = Device nam INW’Conveyor vl Device type: |SI-EP2
olxl
. . Ayajlable devices: :
Verify Device name — : : LLLT
2 CPU 315-2 IP address MAC address Device type | Device name Assign name | J
X7 .
Select Device 7] PO Nade flashing test
X2rr Fort 7 Duration [seconds] 3 Vl
3
4
: |
Flashing an | FElashing off. | 400
. =
Select Assign name —
[~ Show only devices of the same type [ Display only devices without names
Update | Erport
Select Close —_— i — M7, and C7 (dstibuted g
=
W‘P o | _ Heb |
——
Press F1 to get Help. | | Cha 2

Figure 21 -- Assign Name Dialog
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Save, Compile and Download

e Save and compile the configuration
e Download the configuration to the PLC

[ 1w Config - [SIMATIC 300(1) (Configuration) —- PROFinet]

Station Edit Insert PLC View Options Window Help & =]
New... Ctri+N /= | %% | k‘?|
DOpen... Ctri+0
. ot o
Select Station ERE 4 | 2zl
Find: ﬁﬂ gr!
Profile: I Standard j
. PROFinet: PROFINET-0-System (100} .
Save and Compile — | ; B FROFIBUS P |
Properties... =582 PROFINET IO
: B0 Additional Field Devices
Sl ¢ B[] Drives
Export... =1 51EP2
—  Consistency Check Ctri+AltsK 5@ {%EEE_ Prouf:_Bt Option
- e B rive Object
Check Cit Compatibil Ctrls-Al+F -
|| iimete Sl ool o [ 1040 Puofie
i Std Tgm 1
i B | dddress | O address Diagnostic add... | C.. | E o Tgm1 EE
Print Preview... D | " gml + _|LI
Page Setup... B <l *
e SIEP2 £,
1 PROFINetiSIMATIC 300(1} s 5td Tgm1 + 5 FZD Module =
2 PROFINetiSIMATIC 300(1)(1) T | = GSDMLA2 24 askawa-5IEP3-201 00726, i
3 YAL-HQISIMATIC 300 Station

Sav 4 PROFinetiSIMATIC 300 Station I I

H
&

Exit Ali+F4

Figure 22 -- Save and Compile

_1&] x|
p=TE|
Download Module Identification... Find: I Z
7 Upload Module Identification to PG... e ﬂlﬂl
2 CPU 3152 P :
Select PLC X7 Faulty Modules... Profile: ISlandard ¥
ET-I0-System (100) -
Download g - Module Information... L e Y PROFIBUS-PA -
Operating Mode... Ctrl+ *'ﬁ'ﬁl F‘HDFIN.ET lu} ] )
3 E——— {21 Additional Field Devices
4 = B Drives
P E Set Tlme Df[ly E‘D SIEP3
Sluritunilgeliny g SIEP3 Profinet Option
Z B+ Drive Object
:I:I [1) Mw-Conveyor Update Firmware... A 1040 Prafils
i Std Tam 1
Save Device Hame to Memorny Card... Hies || Bemmsie a6 I F gm
T P Std Tgm 1 +5_IiL|
= ' e | | B
PROFIBUS 3 e SIEF3 £
s Std Tam1 + 5 P20 Module
St Tgm1 + 5E2T Save Service Data... 55 GSDML-2 2-vaskawa-SIEF3-201 00726, 5ml

Loads the current station into the load memory of the current module. [ [

:

Figure 23 -- Download to PLC
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Drive Control Programming

Variable table

Create Variable Table

Name the Variable Table

Populate the Variable table with Drive I/O
Set Mode to Online

Enter Drive Variables

Press F9 to Send Modified Values

;J SIMATIC Manager - [PROFInet — C:\Program Files\Siemens\5tep7\s7proj\PROFInet]
£y File Insert PLC View Options Window Help =
= |B% | station Fle gt (23 | < Mo Fiter » jVJ|%§|%EED|k‘?|
/ o B FROFIne  ubmet " fiem data o 0B
Select Insert T SMe Pooram 5
S7 Block =0 0 srsomure >
: — BEEETI 1 orserzaton bock
Variable Table \ MY Software » 2 Function Block
| bol Tabl 2
B o e 4 Data Block
=y 5DataT
External Soi o i
Inserts Variable Table at the cursor position. i

Figure 24 -- Create Variable Table

r__.JI SIMATIC Manager - [PROFInet — C:\Program Files\Siemens\Step7\s7|
S Propertios -Variable Table @] ==l x|
. O |8 | & B | Genenl-Pat 1 . i | 2
Enter Symbolic Name -/ | | | | Genera-Pan 2] Anses | %]
=-{E SIMATIC 2000 e [vaTi
E"' CPU 3152 PN/DP Symbaolic Name: INWCon\raycr_IO|
E|- 57 Program(1)
@ Souces Symbal Comment: |
‘g7 Blocks
Project path: I
Storage locati
of‘l’)’:,?:d‘? i [C:\Program Files\Siemens\Step 7' 7proj\PROFInet
Code Interface
Date created: 12/14/2011 12:02:35 PM
Select OK \ Last modfied: 12/14/2011 12:02:35 FM 12/14/2011 12:02:35 PM

Comment:

I =l

=
o | s | b
Press F1 to get Help. T TTCP [P (AGTG) -= ASIX AXBS178 USBZ.0 | P

Figure 25 -- Name the Variable Table
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

P —
S AR — ]
B Hle Edit Insert PLC = S pEen ME D = LI L L7 =& x|
D 2ex be = D@ 8 speol-] x| =8| ¥ Ylle nam|vl
Bl FPROFInet
- SIMATIC 300(1) | Address | symbol| Display format| Status value Madify value
=@ CPU 3152 FNDRS| = e 7T
[=-{z2] 57 Proaram(1 5 e =
(@ Sourees | i HEX
Blocks
Enter Inputs & S| i s i
PIW [Input Address] 5| Pw o264 HEX
6 | Pwo2ss HEX
7| P 2ss HEX
Y (B
il | Pow 258 HEX
10| Paw 258 HEX
11| Paw 260 HEX
Enter Outputs P |[12] Paw 262 HEX
13| Paw 264 HEX
PQW [Output Address] — g vix
| [15] paw 2ss HEX
16
FEsFldasiisy Press F1 for help. ] 'Z F| A

Figure 26 -- Populate Variable Table

) SIMATIC Manager [NWConveyor_IO - PROFInet|SIMATIC 300(1)\CPU 315-2 PN/DP\ST Program(1)]
. File _Edit : #' Variable View Opfions Window Help =15 x| == x|
Select Variable s — e e =
2 -
D& 87 w DielEl & 87 e el r| 8l | ]
PROFInet = nitor Ctri+F7
SE 1] Display. ™ wndify CtrisFg | vale
il PV 256 BIN

Select Monitor B s 2] e A e
B e 250 HEX Activate Modify Values  F9
4 Fivy 262 HEX Modify Address to 1 Ctri
BRI P 264 HEX, Modify Address to 0 Cirl+0
B PV 268 HEX
- Pl 288 HEX Enable Peripheral Outputs  Shift+Fg
8 Display Force Values Alt+F2
B PAW 256 BIN e
10| Paw 258 HEX StnnForemn
11| Paw 280 HEX
12 POW 262 HEX Modify Value as Comment F3
13| Paw 264 HEX
18| Paw 286 HEX
15| Paw 288 HEX
16

Press F1 to get Help. Starts/Stops the monitoring of the variables depending on the trigger co ,7 2 |UFWHE \Abs <52 ’? | ,7

Figure 27 -- Set Table to Online
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

PROFIdrive
3] Var - [NWConveyor_I0 — @PROFInetiSIMATIC 300{1)\CPU 315-2 PN/DP\ST Progr... [_]O]=] METEY
gg File Edit Insc Ef Table Edit Insert PLC Variable View Options Window Help _|&|X| -1=1 x|
[ @ 2% | _| Dls(E| 8| &m0 x| [ 2] »|| e w s<E BB D%
G- PROFIret Address | Symbol | Display format| Status value Modify value
=
Read 1 B . SIM&I.!.CB. 1 Py 258 2#0000_0011_0011_0111 PZD1 (STW)
Status Word B 57 2 PV 258 HE ey - WH1BHITTO PZD2 (HIW)
Reference Frequency — ] 260 HEX WHIB#0000 PZD3
4| w262 HEX WH1B#0000 PZD4
5 FIW 264 HEX W#16£0000 PzZD5
B PV 266 HEX WE16#0000 E;gg
. 7| w268 HEX W1B£0000
Write =
Control Word' ESS = b s Eég; :z‘;vv\\ll))
L o i P 6770
Frequency Reference - E—— = = brDs
12| Paw 262 HEX 24 E;g‘s‘
Press F9 to Write 13| Paw 264 HEX 24 et
e 14| Paw 266 HEX -4 fined
Modified Values — e =
To the Drive 1
PressF1togetHelp,  PROFInet\SIMATIC 300{1)\...\57 Program(1) <> RO 2 [ e

Figure 28 -- Enter PROFIdrive Control Values

Status words for PROFIdrive profile are not the same as for the Yaskawa profile.
PROFIdrive: Control RUN 007Fh

Control and Status words for the PROFIdrive profile selected in the Cyclic I/O Configuration. Note that the Control and

Yaskawa
L R s
@ File Edit Insert PLC 2 = Opiion= Help —I—I _1El x|
=2 F| 3 BE Elulla
Read =) PROFInet & D@ 8| &|mlefo«] X[ 8] _|| Syl wr| _[
2 =- . SIMATIC 300[1] ,’; Address | Symbol| Display format| Status value Wodify value
Status Word — s T o P Z1100_0000_0010_0001 PZD1 (ZSW)
Reference FrequenCy : s Wi164120C PZD2 (NIST_A)
q y T Souces 3| P 260 HEX Wi1620000 pzD3
ﬁ HEES  |im PIW 262 HEX WH#1640000 PZD4
5 PV 264 HEX VWE16#0000 PZD5
W -t 11 Pl 286 HEX V1640000 PZD6
rite P T Pl 288 HEX W#16#0000 PZD7
Control Word B
Frequency reference L e =  Bediecn PZD1 (STW)
2 i 2 B #16H1TT0 PZD2 (NSOLL_A)
k| PQW 260 HEX B pPzD3
12| | Paw 262 HEX 24 PZD4
. 13| Paw 284 HEX 24 PZD5
Press F9 to Write — s - g
Modified Values 15| Paw z68 HEX 24 PZD7
To the Drive 18
Press F1 to get Help. PROFInet\SIMATIC 300(1)\...\57 Program(1) @ Fn [ 4

Figure 29 -- Enter Yaskawa Control Values

2 Control and Status words for the Yaskawa profile selected in the Cyclic I/0 Configuration
Yaskawa: Control RUN 0001h
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Ladder Logic (LAD)
Control the Drive From the PLC Program with PROFIdrive Profile Selected

E LADISTLIFBD - [OB1 — PROFInet!SIMATIC 300(1\CPU 315-2 PN/DP]
{1 File Edit Insert PLC Debug View Options Window Help _|5||£|

DEed S| BE|o o |eidlal®e | KOO 4O L 7|8
x|

Contents Of: 'Environment\Interface'
E"@ Interface |Name

-2 New network F-F@ TEMR & [TEve

=]

=)

-] Comparator
t-[8g] Converter |
].. Counter m: Set PROFIdrive RUN and Fregquency

+-(£g] DB call on M1.0 Positive Edge Trigger True
(&) Jumps Set Drive RUN

t-(xI] Integer function Set Frequency Refence to 60.0H=z _|
(8] Floating-point fct.
(=] Move

#-(3¢] Program control M1.0 Mz.0 MOVE
ShiftiRotate — | {e} EN  =ZNG
H-[az] Status bits
(@] Timers
(2] Word logic P
t-{£H FB blocks = 0o
+-[£H FC blocks
H-{fH SFB blocks HELEE1770 1IN OUT |-PQWZ58
t-{£H SFC blocks

- Jill Muitiple instances
- @ Libraries Network 2 : Set PROFIdrive STOP snd Zerc Frequency Refersnce

One Shot the command to
Move the RUN command
To STW (PZD1) and the
Frequency Reference to
HSW(PZD2)

L

Wgl6g TF 4 IN OUT -BOWZ5&

T o e T [ e o o e e e e - )

On M1.0 Positive Edge Trigger False
Set Drive SICF
Set Frequency Refence to 0.0Hz

One Shot the command to

Remove the RUN command — {2} o Ewo

To STW (PZDl) and the WELEE0 —|IN CUT |-PQHZ54E

Frequency Reference to WOV

HSW(PZD2) Ty 1 = =wol
WElgg0 - IN OUT -PQW258

ngmme._ |E_ECallstru... ‘I I _DILI
Press F1 to get Help. l_ 2 |offiine |Abs 5.2 [Nw1 WW ,7 &

Figure 30 — Basic Drive Control Program
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software

Change the Acceleration Rate When the PROFIdrive Profile is Selected
e  Enter the acceleration parameter address in F7-33 with the value desired.
o Parameter C1-01 (0200h)
e Power cycle the drive to store and make the parameter value active.

ﬁ LADISTLIFBD - [0B1 — PROFInet\SIMATIC 300{1)\CPU 315-2 PN/DP]

I3} File Edit Insert PLC Debug Wiew Options Window Help _|ﬁ'|1|
D2 HS 4 BERle oo 20| <! [DEE[4F4# 0B L = |82
[El=] Contents Of: 'Environment)\Interface'
E-43 Interface [Wame
B4 New network - TEMR & T2
[#-{30) Bit logic =
#-{Z] Comparator
-5 Converter d
[-{x1] Counter Network 3 : Change Zccel Rate (Yaskawsa or DROFIdrive)
[#-{gg] DB call
[]__@ Jumps Program F7-33 to Z00h (address of C1-01)
_ Drive Must Be Rebooted in Order for Dynemic Verisbles to Be Stored
[-{zD] Integer function On M1.1 Dositive Edge Trigger Set C1-01 to 10.0 S
[ Floating-point fct.
. -z Move
One Shot the Change n [#-{3] Program control M1.1 Mz .2 WOVE
Value to PZD3 [-{g5 ShiftRotate — {p} EN ENO
[H-{ai7] Status bits
@) Timers HEleged —{IN OUT |- PEH2 60
[#-{Z Word logic
[+-{gH FB blocks
[#-{gH FC blocks
[F-{£H SFB blocks
[#-{gH SFC blocks
‘ Multiple instances
- Libraries
Bit logic Bl
@ngmm = E_ECallstru.. | ‘I I Llﬂ
Press F1 to get Help. 2 [offine |abs 5.2 w1 Insert [Cha v
Figure 31 — Control Acc Rate
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Using the Yaskawa ProfiNet Option SI-EP3 or SI-EP3/V with Siemens Step 7 Software
Notes
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